WinCon-8000 Getting Started

(Version 1.4)

Hardware & Software & Application
Using I-7000/I-87K/I-8000 Series Modules

Warranty

All products manufactured by ICPDAS Inc. are warranted against defective
materials for a period of one year from the date of delivery to the original purchaser.
Warning

ICPDAS Inc. assumes no liability for damages consequent to the use of this
product. ICPDAS Inc. reserves the right to change this manual at any time without
notice. The information furnished by ICPDAS Inc. is believed to be accurate and

reliable. However, no responsibility is assumed by ICPDAS Inc. for its use, or for any

infringements of patents or other rights of third parties resulting from its use.
Copyright

Copyright 1997-2004 by ICPDAS Inc., LTD. All rights reserved worldwide.
Trademark

The names used for identification only maybe registered trademarks of their

respective companies.
License

The user can use, modify and backup this software on a single machine. The
user may not reproduce, transfer or distribute this software, or any copy, in whole or in

part.
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Introduction and hardware setup

Welcome to the Wincon-8000 user’s Quick Start manual. ICPDAS provides this

manual for new user how to install the hardware and software quick start.

1.1 Introduction

The main hardware of the WinCon-8000 embedded controller are depicted in
figure 1.1, which include VGA, USB, mouse, keyboard, compact flash, series,
Ethernet and an I/O slot standard interface . ICPDAS also provides another remote
I/O modules. You can communicate the remote I/O modules by pass through the
COM3 (RS-485 network). On the standard Ethernet port, you can use the intranet and

internet advantages such as www , ftp, SQL database application and so on.
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Fig. 1-1

For The software develop, ICPDAS provides two DLL files, namely the
WinconSDK_DLL and the Wincon_DLL, for the I-8000 series modules which are used
in the Wincon-8000 Embedded Controller. The WinconSDK _DLL has all the

essential DLL functions designed for the 1|-8000 series modules for Microsoft
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WinCE.Net platform. It can be applied on embedded Visual C++, Visual studio 2003
C#.NET, and VB.NET on WiInCE 4.1.Net (refer the figure 1.2), and even on the newer
platforms. Users can easily develop WIinCE.NET applications on WinCon-8000 by
using this toolkit. The various functions in WinconSDK_DLL are divided into the
following sub-group functions for easy use in different applications. For more detail
please refer to the WinconSDK.DLL for C#£.NET and VB.NET or WinconSDK.lib for
embedded Visual C++

o
Visual Studio.net

Smart device, Visual C#.net
programmability SWisual Bacic.net

Eembedded Visual C++

Managed code Native code
Applications downloadded

through LAN orstored in

storage card or USB driver

WinCON 8000 ==~ WlndOWS CE.nst

v_

Fig. 1-2

1.2 Hardware Setup( for W-8X3X Only)

There is the W-8731 hardware setup sample (Fig. 1-3). In the right side
connect the standard computer interface like 15 pin VGA port monitor (can
support the touch screen as HMI device), Keyboard, Mouse, and Ethernet. In the
middle and left area, you can plug in the ICPDAS’s I-8K and I-87K series 1/O
modules. The W-87XX can plug in 7(max.) local /O modules and W-83XX for
3(max.) local I/O modules. There is no I/O slot about W-80XX, so it can’t plug in
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any local 1/0 modules. On the under lift side, The COM2 is a standard 5 wire
RS232 com port. You can connect the standard RS232 device (modem ...). The
COM3 is standard RS485 port. You can connect to the RS485 devices like
ICPDAS'’s products I-7K series 1/0 modules and I-87KX expansion unit.
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EEPROM/Flash/SDRAM
Real-Time Clock
WatchdogTimer
Hardware Unique SiN

usBe Parallel Bus
Keyboard I/OExpansionSlot LED Indicator
Mouse

L

— COMPort
{R5232)

COMPort
{RS485)

FARAFFFI RS R R

AR I'_I'I. " l"
FFFFEFFESARYEF

AnaloglinputfAnalog output
Current Loop

Digitallnput/ Digital output
Relay Qutput

Open Collector Output
Counter/F reque ncy

VGA
CompactFlash

LED Indicator

Ethernet Port
Operating Temp.:-25 C~+78 C

Fig. 1-3

By the Ethernet ,you can communicate to the Ethernet devices such as

[-7188EX(palm size Embedded Controller), Motion Controller(Galil's 21XX), SQL
Server , mail Server, MMS Server, iPush Server and so on. (Fig. 1-4)
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Solution for Internet/Intranet

u (Wireless)Modem
USB Device V

Lcd Panel -
i
FRnet

{Option)

| o -\_‘\/ 7000 1/0 Modules

Fig. 1-4

If the devices connect was completed, please connect the DC 10V~30V input to
the under right side and frame ground to the earth ground finally(if you have earth
ground). Please attention that Wincon’s power consumption is low(typical 0.15A at
24VDC) , But On the Power On moment (in 200ms), the Wincon need more current to
start up (typical 1.2A at 24VDC).
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1.3 Hardware Setup ( for W-8X4X only, Dual LAN version WinCon)

Another succeeding WinCon family is W-8X4X . Inheriting almost all
hardware features from W-8X3X, W-8X4X has the same user interface and OS
features. The only difference between W-8X4X and W-8X3X is that W-8X4X
adopts 2 USB ports and two 10/100M Ethernet ports instead of 2 PS2 jacks.(Fig.
1-5). In the left side connect the standard computer interface like 15 pin VGA port
monitor (can support the touch screen as HMI device), Keyboard(USB),
Mouse(USB), and Ethernet (10/100Base x2). In the middle and right-side area,
you can plug in the ICPDAS’s I-8K and I-87K series I/O modules. The W-874X
can plug in 7(max.) local I/O modules and W-834X for 3(max.) local I/O modules.
There is no 1/0O slot for W-804X, so it can’t plug in any local I1/0 modules. On the
under lift side, The COM2 is a standard 5 wire RS§232 com port. You can connect
the standard RS232 device (modem ...). The COM3 is standard RS485 port. You
can connect to the RS485 devices like ICPDAS’s products I-7K series 1/O

modules and I-87KX expansion unit.

RISC CPU 206MHZ
EEPROM/Flash/SDRAM USB Parellel Bus LED Indicator
Real-time Clock USB 1/Q Expansion Slot

Watchdog Timer |

Unique Hardware S/IN

10/100 Ethernet
Reset Key

------
--------
Aarton Emer ¢

COM Port
(RS232)

| COM Port
(RS485)

.....

Anaiog input / Analog output
Current Loop

DC Power in Compact Flash Digital input / Digital output
. Relay Output
LED Indicator | o5nfig Rotary SW Open Collector output

Counter / Frequeney
10/100 Ethernet

Fig. 1-5
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Dual Ethernet ports usually help customers with flexibility and extensibility.
System integrators can implement their network redundant policies(Fig.1-7), or to plan
their business systems and industrial Ethernet network in two separated network

segments to gain more network security. (Fig. 1-6)

Ethemet i PC or Server
switch [T a7

18000
series

Fig. 1-7

If the devices connect was completed, please connect the DC 10V~30V input to
the under right side and frame ground to the earth ground finally(if you have earth
ground). Please attention that Wincon’s power consumption is low(typical 0.15A at
24VDC) , But On the Power On moment (in 200ms), the Wincon need more current to
start up (typical 1.2A at 24VDC).
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1.4 Specifications

Main Control unit

m Intel Strong ARM CPU, 206 MHz m 1 VGA port :
m  SRAM: 64M bytes 320x240x16 to 1024x768x16
m  Flash RAM : 32M bytes Default is 640x480x16
m  EEPROM : 16K bytes m 1 Compact Flash slot : CF memory card
B 64-bit hardware unique B Reset button
serial number m  Power LEDs
®  Built-in Watchdog Timer

®m Real Time Clock

W-8X3X W-8X4X

m 2 PS/2 port: Keyboard and Mouse | B USB 1.1 host x 2
m USB 1.1 Hostx 1 B 10/100 Base Tx 2
10 Base T : NET2000 compatible

Cabinet

COMO: Internal use

COM1: Serial Control for 87k Series
COM2: RS-232

COM3: RS-485

FRnet(option)

I/O Expansion Slot :
3 - slot for W-83X1
7 - slot for W-87X1

Power Supply : 20W, Unregulated + 10Vdc +30Vdc

B Environment :
Operating Temp. : -25°C to + 75T
Storage Temp. : -30°C to +85C

® Humidity : 5~95%

B Dimensions :
115.66x110x93.8(none slot)
230.25x110x93.8(3 slot)
354.26x110x93.8(7 slot)

® /O module(optional)
[-8000 series modules, which include DI,DO,AQ,AI...
[-87K series modules, which include DI, DO,AQ,AI...
[-7000 series modules, which include DI,DO,AQ,AI...
For more information please refer to relative catalog or http://www.icpdas.com

WinCon-8000 Getting Start Manual-- 9




1.5 Dimensions
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7 slots :
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1.6 What’s News

Added 2.3 I-87K Module Settings tool by DCON_Utility of PC.
Added 2.2 New CARD Wizard function for I-81XX Serial Card.
Added 1.3 Specifications

Added 1.4 Dimensions

1.7 Package List

® One set of WinCon-8000 hardware
® One Compact Flash card for storing system files.
® One software utility CD
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2. Wincon-8000 System Settings

In this section, we will explore how to set the Windows CE System and the
“WinCon Utility” for the Wincon-8000 embedded controller. You can change
configurations, such as the system time or network setting of the Wincon-8000
through the Windows CE control panel. WinCon Utility allows you to view
Wincon-8000’s information or save the current system configuration into Windows CE

OS image.
2.1 Windows CE Settings

Setting Up the System Time

You can setup a new date or time in the Windows CE system by using the

following steps:

1. Choose Start > Settings - Control panel to open the Control panel dialog.

File ¥iew Lﬂ EI

5, - = Loy = #
4, L = T @ 8 B
Certificates  {HEW=TEEEE Display kKeyboard Mouse  Metwork and  Owner Password
Dial-up Co..,
o o i P -’
5 H P ® W Jo
PC Poweer Regional Storage System YWolurme &
Cornection Settings Manager Sounds
Fig. 2-1
2. Double click the Date/Time icon on the Control panel dialog.
DatefTime Properties m _
Date/Time i

(4] July 2003 ) Current Time _
|Bhizzz e =

S M TWTEF S

50 30 1 E 3 4 5 Time Zone

B # B 918001 12 : ipei

13 14 15 16 17 16 1o [I(GT+0B00) Tape =

20 21 22 23 24 25 Z6 |1 Automatically aelicst clack far dayvliaht saving

27 28 29 30 31 1 2 |

1 4 5 & F B 9 L apey
Fig. 2-2

3. When the Date/Time Properties dialog displays, set the date or current Time
and click the Apply button to set your system date and time.
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= Note: If you have changed any value of the date and time. You must save
the registry by means of WinCon Utility tools. For more information about
WinCon Utility tools, please refer to the WinCon Ultility section.

Setup the network

Generally, most users don't need to setup the network because DHCP is the
default setting. However, if your network system does not contain a DHCP server, you
need to configure the network setting by using the manual method. The following
steps demonstrate the procedure for how to configure the network system.

1. Choose Start &> Settings - Network and Dial_up Connections on the

Windows CE desktop to open this dialog.

2. Double click the LAN90001 icon to open the “LAN9000 Network Compatible
Adapter Settings” dialog.

'LAN9000 Network Compatible Adapter® Settings

A1 1P address cah be () Dbtain an IP address via DHCP
autornatically assigned ta this o .
computer. If your network @ Specify an 1P address:

does not automatically assign :
IP addresses, ask your network i 182 .168.254.200 |

administrator for an address, Subnet Mask: |255 255.0 .0 |

and then type it in the space -

prewiced, Default Gateway: [192.168.255.254 |
Fig. 2-3

3. When the “LAN9000 Network Compatible Adapter Settings” dialog displays
(see figure), click (enable) the “Specify an IP address” radio button in the IP
Address tab and type in the IP Address, Subnet Mask, and Default Gateway
into the respective fields.

4. Choose the “Name Servers” tab and also type in the Primary DNS,
Secondary DNS, Primary WINS, and Secondary WINS into the respective
fields, as shown in the figure below.
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I. iF‘mﬁ.lT:I_dregsi hame Servers l

MName server addresses may be Primary DS,
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s enabled on this adapter.
Yo can specify. additional
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space provided,

Secondary DRS;
Primary WINS;
Secondary WINS:

'LANQO00 Network Compatible Adapter' Settings

||. 95,192, 1

[iEg 95,1, 1 |
[ . ]
L. . |

Fig. 2-4
5. Click OK.

= Note: If you have changed any value of network configuration, you must
save the registry by means of WinCon Utility tools. For more information
about the WinCon Utility tool, please refer to the WinCon Utility section.

Setting up the Device Name

You can configure Wincon-8000 to have the device name of your choice. To

change the device name please refer to the following steps:

1. Choose Start > Settings - Control panel to open the Control panel dialog.
2. Double click the System icon on the Control panel dialog to open the System

Properties.

3. When the System Properties dialog is displayed (see figure), select the

Device Name tab in the dialog window.

(Gonl ey | O ||

T other computets,

Deyvice pame:

J Thiese settings are Lsed to identify your Windows CE device to

Flease type a name (without any spaces) and a short description,

Devire. descrption: !WindDWSCE Dievice

Fig. 2-5

4. Type your preferred Device Name in the Device Name box, and click OK.
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= Note: If you have changed any information of the Device Name, you must
save the registry by means of WinCon Utility tools. For more information
about the WinCon Utility tool, please refer to the WinCon Utility section.

Here, we only provide some demonstrations for configuring your settings. The
configuration steps and operation methods are the same as with the windows system.
However, you need to keep in mind “if you have changed any setting on
WinCon-8000 embedded controller, you would need to use the WinCon utility to
save the current setting into non-volatile internal memory”. Otherwise, when you

restart the system, the setting will not change.
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2.2 WinCon Utility

The WinCon Utility provides many tools to save/view the system information
registry and to setup the HTTP/FTP path and update non-volatile internal memory
within the Wincon-8000 embedded controller. This handy utility (WinCon Utility 1.exe
located in the Compact Flash/icpdas/Tools directory) should be located in the
computer's Program group. Therefore, you can launch it on the computer through
Start > Programs - WinCon Utility menu. The WinCon Utility provides many
functions within the following five tabs:

Save Registry Tab

System Config Tab
Auto-execute Tab

Version Update Tab

Com Tab

About WinCon Utility 1 Tab

Save Regqistry Tab

This tab provides functions to save/view the registry of the systems information
and to setup the HTTP/FTP directory path. It is very important to save the registry
when you change any system information. Then you need to click the “Save
and Reboot” button to renew the system configuration. If you do not save the
current configuration into the registry, you will lose your information settings

when you reboot the Wincon-8000.

= Note: The OS image in flash memory will crash if we push the reset or
power-off buttons for WinCon-8000 whilst it was writing the registry
settings to flash memory. It will take 10-15 seconds to save the
registry settings. Add these notes to your user manual because it is
very important!
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WinCon Utility 1 [Ver 2.1.0]

Save Redistry | Systemn Config | Auto-sxecute | varsion Undate | com | About winCon Utility 1 |

It will take several seconds to save your settings to
‘ 4 & ‘.“ﬁa g registry, and settings yvou changed wil take effect
\ & N after systemn reboot,
\ B . .
i ‘{%_ Save and Reboot
(AT
Change all settings to factory default settings
Recolution : 640 % 450 540 x 280 % | Recaver to Factory Settings I
Bpp: 16 16 = : :
Frequncy : 60 Hz m any setting changed could be pre-viewd,
Wiew Registry
| Change |

Change FTP default directary \Ternp to
Change

|\Temp
Change HT TP default directory YCompact Flash\TernpHT TP o
I\.Compact FlashiTernpHT TP Changde

Fig. 2-6

The Save Registry tab includes the following folders:

® Save and Reboot button: It will take several seconds to save your settings
into registry and non-volatile internal memory. You must then reboot the
system for the new configuration.

® Recover to Factory Setting button: It will take several seconds to clear
your registry settings back to Factory Setting and Wright to non-volatile
internal memory. You must then reboot the system for the new
configuration.

® View Registry button: Any settings are changed in the WinCon embedded
controller can be pre-viewed by using this function. It is just like the ?regedit
function in the windows system that you are very familiar with (shown in

below figure).

File Help

‘[ HKEY_CLASSES_ROOT Marne | Data
[0 HKEY_CURRENT _USER
0 HKEY_LOCAL_MACHINE
B0 HKEY _USERS

Fig. 2-7
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® Change the VGA resolution box: You can setting the VGA Resolution to
320x240,640x480,800x600 or 1024x768, and 2,4,8,16 bits color (Bpp),the
monitor reflash Frequncy for normal TFT LCD setting is 60 Hz.

® Change FTP default directory to box: Enter a FTP default directory path
and click change button to setup the defined path to the ftp server.

® Change HTTP default directory to box: Enter a HTTP default directory path

and click on the change button to setup the defined path for the web server.

System Config Tab

The System Config tab allows you to view the information in the Wincon-8000

embedded controller system.

winCon Utility 1 [Ver 2.1.0] o]l x |
[ Save Registry }-SYStEFﬂ Config ] Auto-execute I‘Jersin:un Lipdate ICDm l Ahout WinCon Utility 1-|

Siot 1: - [1-8041 - Serial Murnber : 910546830090

Siot2: 8040 M e 00:0D:E0: FO: 00 : B9

Siot3: [8017 EEPR AN S 16K bytes

Sit4: [reo24 Flash Mernory Size 32M bytes

SlotS5: | OE Vereier : CE.MNet 4.1 2,04.09.02. TC.EGU

siot 61 157064 s i 28056244 bytes

St 7: 18077 . WinCon S0k Yersion WinCon SDK 2.0.1

Fig. 2-8

This tab includes the following folders:
® Slot 1~7 box: The Slot1~7 fields display the module names plugged in the
Wincon-8000.
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® Serial Number box: This field displays the serial number of the
Wincon-8000.

® MAC address: The field displays the physical address of Ethernet port.
(For W-8X4X, upper field displays 1% Ethernet MAC address, Lower field
displays 2" Ethernet MAC address)

® EEPROM Size box: This field displays the EEPROM size of the
Wincon-8000.

® Flash Memory Size box: This field displays the Flash memory size of the
Wincon-8000.
OS Version box: This field displays the current operating system.

® OS Image Size box: This field displays the size of the current operating
system.

® WinCon SDK Version box: This field displays the current WinconSDK_DLL

version.

Auto-execute Tab

The Auto-execute tab, provides ten execute files, which can be run after the
WInCE system has been launched on the WinCon-8000 system. You can set ten
execute files through the Browse button on the tab for WinCon Ultility, as shown in the

below figure. Note that they are executed in order of program 1, program 2, ...
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WinCon Utility 1 [Ver 2.1.0]

Save Registry I System Cl:unﬁg_i Auto-execute I‘u‘ersin:un Lpdate I Com Iﬂxbn:uut WinCon Utility 1 |

Prograrm 1 ! Browse |
Program 2 : | | Browse |
Program 3 ; ! Browse |

At most 10 programs can

be specified to execute Program ¢ : | |_Browse |

automatically when systern

starup, And there is none Program 5 : ! Browse |

dependency between

each program, Program 6: | | Browse |
Program 7 ! Browse |
Program & | | Browse |
Program 9 ; ! Browse |
Program 10 @ | __Erowse_|

I Save Setting l

Fig. 2-9

The tab includes the following folders:
® Program 1~10 boxes: These files allow one to configure the auto-execute
files for Wincon-8000 for when it is started up. You can choose the execute
file and file directory path by means of the Browse button.
® Save Setting button: If you have changed the settings for the Program 1 ~
10 field contents, you must then click the Save Setting button before closing
the WinCon Utility window.

Version Update Tab

The Version Update tab provides the function to be able to update newer
versions of the operating system. Users can download the OS image file from the web

site: http://www.icpdas.com. You can choose the new OS image file name and

directory path with the Browse button. Click the “Write to flash now” button to update
the current OS version. It will take ten or more minutes to update your OS to Flash

memory, and then reboot your system.
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WinCon Utility 1 [Ver 2.1.0] E
| Save F{egiztrﬁ;.].SyStem Cu:unﬁg"} Auto-execute Wersion Update ]..Cum.]' Ahout WinCon Utility 1 ]

Specify the new OS image file for version update

| Browse

| ex | WServerMarme\ShareFolderMameink. bin

Wirite to Flash now

Fig. 2-10

ComPort Tab
Fig. 2-12 Wincon-8000 show set the touch screen Com Port No, now we can support
ELO,3COM Dynapro,EGALAX....,Please plug in the right Com Port No -

WinCon Utility 1 [Ver 2.1.0]

| Save F{egistry_.} Systern Config ]_.&uto-execute ] Sersion Lpdate | Com 1 About WinCon Litility 1]

Serial Touch Change ComPort
[ 9 Disable )
Elo COm0;

Dwynapro COM0:

1o:
Il

Egalax COMO;

Parallel Commmunication Modules Setting

t Mewr Card Wizard I

Fig. 2-11
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Setting the 1-81XX Serial Port
1. To click New Card Wizard button and show the New Card Wizard Window:

New Card Wizard (Ver 1.0) m m

~Card Marme———  Resource

Clotd j

Slotz .

Slot3 .
Slot
Slots ¢

Slots

Slot? ¢

AT

| Slot Scan i

rRedistry -Registry for Factory Setting

Save MNew Module ‘ Factor Default | Save

2. To click Slot Scan button and show all Cards in system:

Mew Card Wizard (Ver 1.0) m H
-Card Marne -Resource
Slotl: |04 PR Y=ot 1: 50471 (Digital Out)
IEP;‘- Slat_2: 8040 (Digital In)
Slats . !BDﬂlD =& Slot_3: 8017 (Analog In)
; =@ Slot_4: 8024 (Analog Out)
Slot3 ; [a017 =% Siot_S: 8114 (Serial Part)
i owe-? Davicel
Slot4 : [5024 H
g% DeviceZ
: w8 Devices
Sints : [5114 7
. =8 Daviced
Sloth l w--# Slot_7: 8077 (Digital In Out)
Slat? : iE{D??

i Slot Scan i

rRegistry -Registry for Factory Setting

‘ Save Mew Module ‘ Factor Default Save
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3. To click Save New Module button and save the setting:

-Card Marne -Resource

Siot1 : [ao41 = Elot_1: 8041 (Digital Out)
5 ----- # Slot_2: 8040 (Digital In)

Slot2 IBD4D =& Slot_3: 8017 (Analog In)

: = Slot_4: 8024 (Analog Out)
Slot3; [a017 = Slot_S: 8114 (Serial Port)
el fonma &% Devicel
clats It will take few minute to create registry for new Module,

I1Systerm rust be reset to active thern,)

o [ ¥er : Cancel
Slot ™ Iguﬁ

Slot Scan

-Registry -Registry for Factory Setting
Save Mew Module Factor Defatlt | Save

4. To click Yes button and reset to finish adding Com Port.

New Card Wizard {(Ver 1.0) m
-Card Marme———  (Resource
Slotl : [ao4g1 PR E-iot 1. 5041 (Digital Out)
=& Slot_2: 8040 (Digital In)
Slat2 : 18040 w4 Slat_3: 8017 (Analog In)
: =4 Slot_4: 8024 (Analog Out)
siot3 : [e17 =4 Slot_5;: 8114 (Serial Part)
Powed COMS:
slotd : [a024 :
we- i COMEG!
cEm | & COMT:
Slots |:3114 :
e COMB:
SOt I = Slot_7: 8077 (Digital In Out)
Sloty . igD??
| Slot Scan |
-Redgistry -Registry for Factory Setting
Save Mewr Module Factor Default Save
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About WinCon Utility 1 Tab

This tab provides an easy function to hyperlink to the ICPDAS World Wide Web site
http://www.icpdas.com. This is the best place to go for the latest developments, and
support information, application stories, and product news.

2.3 |1-87K Module Settings

When the module of I-87K is put in the slots of WinCon-8000 - it can be set up
through the DCON_Utility of PC - The method is easy to use - When you do it
orderly » you will find it is easy to set up the parameter of the |1-87K module -

1. You must prepare for a cable(CATG6) to start the DCON_CE of WinCon for
PC through ethernet (telnet to use) - To prepare one line of Full Null

Modem and connect the Comport of PC and the COM2 of WinCon-8000
(data transmission) -

&r— 5
e :9 ! - 0O
|.E|_ 1 — - frE
= &g —®
(Sr— —3)
T4, - (L)
[ 2 — —f E )
- B —
1 ..__'1 =
DB-9-1 DB9-2
Receive Data 2 3 Transmit Data
Transmit Data 3 2 Receive Data
Data Terminal Ready 4 6 -1 | Data Set Ready - Carrier Detect
Signal Ground 5 5 Signal Ground
Data Set Ready - Carrier Detect | 6 -1 4 Data Terminal Ready
Request to Send 7 8 Clear to Send
Clear to Send 8 7 Request to Send
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2. To confirm the DCON_CE_V200.exe in the folder of WinCon-8000
\Compact Flash\ICPDAS\Tools

3. To enforce the DCON_Utility V4.3.8(later vision) of PC and press the
connective button of Telnet to open the DCON_CE_V200 V2.0.0
(WinCon-8000) -

El DCON Utility Ver. 4.3.8

m COM Fort JBearch  Eun  Terminal Help

- The Found Cut I-7000/8000 module ...

D"I n|§| e Telnet button

AN
bodule i Address ]\Eaudrate I Alarm Checksum I Description

BaudRate setting 115200 bps
user can change Comport (COM 1 > COMn...)

~Searchin A
COM FPort{ lcOM 1 Address: bU[de[:] Olhex] Baud Rate: 600

1132 \

4. Toinput the address of IP of WinCon-8000 -

Port. Sa

' The 1-7000/8000 Modules Found ...

BlE|8| 00| =
hodule !Address IElaudrate ]Alarm Checksum Description

WinCon IP Address

Flease inputthe WinCon IF Address oK |

Cancel
< [toooion )
£ I b
~Searching Status:
COk Fort: ICOM 1 Address: !01 [decl I 1Thex] Biaud Rate: ] 115200
| HENI p
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5.  After connecting the WinCon-8000 - refer to the manual of the DCON_Utility
to use - please -

DCON_CE exit button

n|n|§; |rr|r gl L

Module i Address I Baudrate ] Alarm Checksum l Description
WinCon 8000 1017 115200 Dizable WinCon Firrmaare Yersion: 2.00
WX, =0 [BK. maodule] ar [Mone]
XK, 31 [BK. module] ar [Mone]
WX, 32 [BK. module] ar [Moneg]
115200 Dizable 4-CH Analog Output
115200 Disable 8-CH Thermo. Input

[BK. module] ar [Mone]
[BK module] or [Mone]
115200 Disakle 40!+ 4 Relay DO

—_S-ear-::hing Statux
COM Port |00k 1

Address: !Uﬂdecl IT[hex] Baud Rate: 9600

1144 | p

[ Setting Configuration for 87063 (87K) A2.00 [X]
1-87063

- Digital Output | 10 - Dty
LSE [CH:0) MSE [CH:3)

-Power On Value of DD —— - Safte VYalue of Dl ——

- Digital Input —| 0 ] 0=0
LSE [CH:0O) FMSE [CH:3)

- Configuration Setting S H

Protocol:
Address:

Checkszsum:

B audrate:
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6. To press the exit button of DCON_CE and it can close the
DCON_CE_V200.exe of WinCon-8000 - Moreover - it will exit automatically
when the DCON__Utility does not work during the programs automatically
scan in thirty minutes -

DCON_Utility

Ty =

Please operate the methods according to the steps - If you find the abnormal
situation > you can close the DCON _Utility first and then power ON/OFF WinCon8000 -

Web Download :
1) DCON_Utility (PC side) = http://www.icpdas.com/products/wincon/winconutility.htm
2) DCON_CE (WinCon) = http://www.icpdas.com/products/wincon/winconutility.htm

Finally you may react the questions to service@icpdas.com - please - Thank you !
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3. Architecture under WinCE.NET

The WinconSDK.DLL & Wincon.DLL are the dynamic link library (DLL) files that
are designed for applications running on the Wincon-8000 main controller unit and its
modules with Windows CE.NET. The user can apply them to develop their own
applications with many development tools, such as embedded Visual C++, Microsoft
Visual Studio 2003 C#.NET, and Visual BASIC.NET. In order to assist you, there are
many demo programs provided for the user when using EVC++, C#£NET and VB.NET.
Based on the demo programs, users can easily understand how to use the functions

and develop their own applications within a short period of time.

The relationships among the WinconSDK.DLL, Wincon.DLL and user’s

application are depicted as follows:

Application Layer

VB .NET/C#.NET
EVC**4.0 and 12003 and Interface functions for C#.NET/ VB.NET
new version FaN o 2003 and new version
Wincon.DLL
* * Driver Layer

[-8000 series Module functions for

ettt EVC™, C#.NET, VB.NET

Physical Layer

Fig. 3-1

Functions for the Wincon-8000 Main Controller Unit;

1. Get Module ID functions;
2. Analog Input/Output functions;
3. Digital Input/Output functions;
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Motion card application functions;

Encoder card application functions;

Support for eMbedded Visual C** Language;
Support for Microsoft® Visual Studio® .NET 2003 C#;
Support for Microsoft® Visual Studio® .NET 2003 VB;

© N o ok

The DLL functions in Wincon_DLL are designed for WinCE.NET and can be
utilized by C# and VB.NET. The main characteristics of the Wincon_DLL that have
been developed the application in the C#NET and VB.NET developer environments,
are very simple to use just like the applications in ActiveX(OCX) controls. Users can
easily find the method they need for their application from the descriptions in the

following section and in the demo programs developed by ICP DAS.
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4.1 Installation Wincon-8000 SDK for EVC on PC

“Wincon-8000 SDK for EVC ” consists of the following major items.
® \WinCon SDK DLL & library files for EVC
® WinCon SDK include files for EVC

® Demo files

Step-by-Step Installations of WinconSDK

1. Please insert the CD-ROM into your CD-ROM driver.
2. Then run “WinconSDK_8XXX_EVC_YYYYMMDD.msi” in the folder of

CD-ROM: \SDK\.

3. After successfully installing the software:
B WinCon SDK library & DLL files are located at C:\Program
Files\Windows CE Tools\wce410\SA _IA\Lib\ARMV4
B WinCon SDK include files for EVC are located at C:\Program

Files\Windows CE Tools\wce410\SA _IA\Include\Armv4
B Demofiles are located at C:\Program Files\Windows CE

Tools\wce410\SA_|IA\Pac\Wincon
4. SA_IA is the hardware platform name for W-8X3X . For W-8X4X, WCE
configuration name is SADU_SACR.

Demo - Microzoft eMbedded ¥izual Co# - [DemoDlgcpp]

[ Fie Edit Yiew Insert Project Buld Tool Window Help

EE = - B ma - - IET %dmsooo R ™
][:Elemu[lig H-o EeEiie.sij["iﬁhi'ﬁe&ﬁ_ni'i' /j-}-\

Demo ~|[sa 1 ~||Wjn32 (WCE ARMV4) Release  £][SA_IA Device ) &t

e DutTEWU?{DuHENN

DutTemp={m_| T ()==1)7{DutTenp|

@%"6‘“‘"3‘;3: “Amma’i-} projacks) DutTenp=(m_DD24-GetCheck()==1)2(0utTenp|
EMOMET. OutTemp=(m_DOZ7 .GetCheck()==1)7{0utTenp|
= ‘3 Source Files DutTemp=(n_pO28 .GetCheck()==1)7{DutTenp|

2] Demo.cpp DutTemp=(p/D029 .GetCheck()==1)?{0utTenp|
[#] Demo.rc DutTempsom_| _DO30.GetCheck( )= =1)7{0utTenp|
|#] DemoDlg.cpp OutTe {rﬂ D031 .GetCheck({ )==1)?(0utTenp|
[#) StdAbe.cpp if number==32)

= /=9 Header Files 90:32{s.luthl:l, OutTemp);

[E] Demo.h

[£) DemoDlg.h

|E] newres.h

|Z] Resource.h

[E] Stdakeh {
+ _1RAesource Files

) ReadMe.b WCE| platfofttrCifguratienyeo0

# 1 External Dependencies S .
£F TODD: Add your control natification handl

int temp,slot;

char string1[28];
slot=n_SlotD0._GetCurSel()+1;
temp=GetHameOfHodule(slot, stringl};
slotDO=slot;
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4.2 Installation Wincon-8000 SDK for VS.NET on PC

“Wincon-8000 SDK for VS.NET ” consists of the following major items.
® WinCon DLL files for VS.NET
® Demo files
The Microsoft Visual Studio .NET 2003 software program must be installed
before attempting to install the “Wincon-8000 SDK”. If you have not already installed
the Microsoft Visual Studio .NET 2003, please refer to the Microsoft document to
assist you in installing the software package first and then you can follow the below
steps to install the development toolkit provided by ICP DAS for the easy application

of Wincon embedded controller platform.

Step-by-Step Installations of WinconSDK for VS.NET

1. Please insert the CD-ROM into your CD-ROM driver.
2. Then run “WinconSDK_8XXX_dotNet_YYYYMMDD.msi” in the \SDK\. folder
of CD-ROM:

3. Follow the instruction to go forward step by step.

4. After successfully installing the software:

B WinCon SDK DLL files are located at C:\Program Files\Windows CE
Tools\wce410\SA_IA\Dotnet

B Demo files are located at C:\Program Files\Windows CE
Tools\wce410\SA_|IA\Pac\Wincon

B SA _IA is the hardware platform name for W-8X3X . For W-8X4X, WCE
configuration name is SADU_SACR
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5. Start The First Application Program

5.1 Applications in eMbedded Visual C*™* (MFC)

All the eMbedded Visual C** 4.0 demo programs are listed in the directory under
“C:\Program Files\Windows CE Tools\wce410\SA_IA\Pac\Wincon”. They have been
tested OK in WIinCE.NET4.1 or newer versions and in the eMbedded Visual C++ 4.0

development toolkit.

When users want to create a new program, they have to use these files from the

EVC™ environment toolkit, as shown in the following:

1. \WINCON\INC\WinconSDK.h-> include all .h files

2. \WINCON\INC\WinCon.h - functions for D/I, D/O

3. \WINCON\INC\i8017h.h - functions for I-8017H Module
4. \WINCON\INC\i8024.h - functions for 1-8024 Module
5. \WINCON\INC\i8090.h - functions for I-8090 Module
6. \WINCON\INC\i8091.h - functions for 1-8091 Module
7.

\WINCON\LIB\WinconSDK.lib = import library of WinconSDK.DLL

The application procedures for how to create a program are listed below. More

detailed information for each step will be described in the following section.

Create a Forms-Based Application;
Specify the Locations for Demo Files;
Configure Compiler Options;

Design an application program;

Build the application program;

Execute the application program on the Wincon-8000 platform;

N o o ks~ oDd-=

Example list for the reference of user program design.

5.1.1 Create a Forms-Based Application

A form is the dialog box with control items that lets users access and possibly
change data. You may want to develop an application in which the user chooses from

a selection of forms. Commonly, a forms-based application allows the user to choose
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“‘New” on the “File” menu to access forms. A dialog-based application, which does

provide menus, is also considered a forms-based application.

Users can apply the WCE MFC AppWizard (exe) to create a forms-based
application. When creating a new form, they have the choice to create a single

document interface or a dialog-based application.

e A single document interface (SDI), forms-based application allows only one
instance of a particular form to run at a time. However, it is possible to run
different forms at the same time from an SDI, forms-based application by

selecting a new form from the “New” command in the File menu.

e Adialog-based application is a form based application by definition. However,
if you choose this option, you will not be able to use the “New Form”
command on the Insert menu to add additional forms to the application. A
dialog-based application does not use the document/view architecture. So,
when you need to add forms, you have to manage the creation and access

methods for them.

The last step of the wizard lets you view and change settings for the classes
created by the wizard. For a single or multiple document interface application, you
should set “CformView” as the base class for the view class of your application. If your
application is database supported, you can also select any class that is derived from
“CformView”. A form is any window derived from “CformView” or from any class that

comes from “CformView”.

To create a demo for forms-based application

1. Firstly, users need to open the EVC™ software. Then, in the “File” please
click the “New” to open a new program.

2. Inthe “Projects” tab, select “WCE MFC AppWizard (exe)” and set the
Project name: “Demo” and the “Location” ,then select the location that you
want . Then, select “Win 32[WCE ARMV4]“ in the CPUs list box and other
options if necessary. Finally click “OK” to start the wizard process, as shown
in the following figure.
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21

Files Projects | Workspaces

=|WCE Application Project name:
£/ WCE ATL COM AppWizard

|Demu|
|%] WCE Dynamic-Link Library
WCE MFC ActiveX ControlWizard .
Logation:
W4 WCE MFC AppWizard (dll) st
RAWCE MFC AppWizard [exe) |C:APROJECT\Demo =

%] \WCE Static Library

' Create new workspace
1 Add to current workspace
[T Dependency.of:

| =

CEUs:

WIWin32 (WCE ARMY4) -
CWin32 [(WCE ARMV4I]

CWin32 [(WCE ARMVAT]

CWin32 [WCE MIPS16]

CWin32 [WCE MIPSH)

CIWin32 [WCE MIPSII_FP] xl

0K I Cancel |

Fig. 5-1-1

3. The configuration of WCE MFC AppWizard.
(3a) WCE MFC AppWizard: Step 1 of 4: Set “Dialog based” as shown in the

following figure. Click “Next” to go to the following step.

WCE MFC AppWizard fexe) ~Step 1 of 4 2| x|

Applicatios

What type of application would you like to
create?

" Single document

¥ DocumentView archilecture suppori?

What language would you like your resources

in?
=l

< Back I Next > | Finish Cancel |

Fig. 5-1-2
(3b) WCE MFC AppWizard-Step 2 of 4: Please enter a title for your dialog in
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the defined area and click “Next” to go to the following step (see figure
5-1-3).

WCE MPFC AppWizad fexe) -Step 2 of 4

i |

I~ Windows Help

[~ ActiveX Controls

Please enter a title for your dialog:

Demao

Help contents file) |Demn_hi‘p

< Back I Next > | Finish | Cancel |
Fig. 5-1-3
(3c) WCE MFC AppWizard-Step 3 of 4: In this step, please choose “Yes,

please” to generate source file comments. And set the MFC library as

a shared DLL or statically linked library. Then Click “Next” to go to the

next step.

" No, thank you

How would you like to use the MFC library?

* Ag a shared DLL

" As a statically linked library

< Back I Next > | Finish | Cancel |
Fig. 5-1-4
(3d) WCE MFC AppWizard-Step 4 of 4: Click the “Finish” button to start the

AppWizard to create the classes, which are shown in the figure below.
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(see figure 5-1-5).

WCE MFZ AppWizard (exe) -Step 4 of 4 _ﬂﬂ

AppWizard creates the following classes for
CDemoApp
CDemoDig
Class name: Header file:
!CDemuApp |D:‘:nm!-_|3p.i|
Base class: Implementation file:
i(JWim‘mp |D:‘;nm£‘-.|:-p.r.pp

< Back | Next > | Finish | Cancel

Fig. 5-1-5

5.1.2 Specify Locations for Demo Files

The Directories settings in Options for eMbedded Visual C™ specify search

paths for files in your projects. These include lists of paths for the following types of

files:

File type

Path contents

Executable files

Specify locations for the build utilities, such as the compilers
(CL, CLARM, CLMIPS, and so on), NMAKE, LINK, and
BSCMAKE.

Include files Specifies where the compiler should look for “include” files (for
example #include <stdio.h>).

Library files Specify where the linker should look for libraries to resolve
external references.

Source files Specify where the debugger should look for default source files,

such as the Microsoft Foundation Class Library and the
Microsoft run-time library.
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Path information is stored in directory settings and it allows you to configure them.
You can change both the paths listed in these settings and the order in which

eMbedded Visual C** searches for them.

The path specifications have separated the setting for the different devices and
the different platforms (such as WCE emulator) supported by your installation of
eMbedded Visual C*".

To specify default folders for demo project files

Open the “Options” dialog in the “Tools” menu.

2. Inthe “Directories” tab, select the “SA_IA"(for W-8X3X) or
“SADU_SACR’” (for W-8X4X) on the “Platform” item, “Win32 [WCE
ARMV4]” in the “CPUs” item and also the “Show directories” in the
“‘include files” or “Library files” item.

3. Since all the WinCon specific include and library files have been
allocated in default directories, users don’t need to modify the contents of
default directories of include and library files .

4. Fig 5-1-6 display the default location of include files.

Tabs | Debug | Compatibility | Download | Build Directories | So [1]5]

Platform: CPUs: Show directories
S _IA Rdliwin32 pwCE ARMVA ~|/include files  ~|
Directories: i '?'( + 4+

CAPronaram FilesiWindows CE Toolsiwced1045A [A\IncludelARMY A
CAProqram Files\Window®s CE Tools\wced1MSA IAAmfclinclude
CAProgram Files\Windows CE Tools\wced1\SA 1A\atinclude

Location of WinCon SDK Include files

Ok Cancel

Fig. 5-1-6
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5. Fig 5-1-7 displays the default location of Library files.

CAProgram Files\Windows @

Location of WinCon SDK Library files

Tabs | Debug | Compatibility | Download | Build Directories | S0 [{v]

Platform: CPUs: Show directories
SA_IA ~v||Win32 (WCE ARMV4) BdliLibrary files -
Directories: N O I &

CProaram FilesYWindows CE Toolsbhweed1 0454 1AMIDBVARMY A
ToolshwoedTMSA [A\mfcllibl\ARMY 4
CAProgram Files\Windows CE Tools\weed10\SA 1A\atiib\AR MY A

0K

Cancel

Fig. 5-1-7

»=  Note: If you want to remove a folder, select it and then press DELETE.

5.1.3 Configure Compiler Options

To set the compiler options in the development environment, please follow these

steps:

1. In the “Project® menu, choose “Settings” to open the “Project Setting”

dialog.

2. Select the configuration “Win32 [WCE ARMV4] Release” in “Settings

for” item as shown in following figure.
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Settings For:

|Win32 [WCE ARMY4) Release  ~|

All Configurations
Multiple Configurations...

|Win32 (WCE emulator] Debug
Win32 (WCE emulator] Release

21x
General | Debug | CIC++ | Link | Resources I M' EE

Hesel

Microsoft Foundation Classes:

Use MFC in a Shared DLL Be

~ Dutput directories

Intermediate files:
|AHM‘J4ReI

Qutput files:
IAHMVdReI

[~ Allow per-configuration dependencies

OK Cancel

Fig. 5-1-8

3. Inthe Project Settings dialog, select the “Link" tab and set the library file

name as “WinconSDK.lib” in “Object/library modules” item.

Settings For:

|Win32 [WCE ARMV4] Release  ~|
B

21
General | Debug | CiC++ Link | Besources l H EE

Category: Inggral j Heset |

Output file name:
|AHMV4He|.fDemu.exe

Objectflibrary modules:

incon3DK.lib

[T Generate debug info [" Ignore all default libraries

[ Generate mapfile

Project Oplions:
YWinconSDKlib Inologo fhase:'0x00010000" il
=l

fstack:Dx10000,0<1000 Jentry:"wWinMainCRT Startup”
fincrementalino /pdb"ARMVARel/Demo.pdb"

oK Cancel

Fig. 5-1-9
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5.1.4 Design an Application Program

After you finish the initial creation of a project, you can build user interfaces.
These interfaces can involve the first design and creation of dialog boxes, menus,
toolbars, accelerators, and other visual and interactive elements. Then you can
hook them up to code. Due to the difference in size and shapes of devices, the user
interface elements must be tailored to the design requirements of each targeted
device. In the following we will explore some methods on how to create control items

in the user’s program.

To create an Edit Box:

1. In the "Workspace“window, select the “ResourceView“tab. Click on the
“‘Dialog” folder to expand it and double-click the “IDD_DEMO_DIALOG" in
order to open the dialog form as shown in below figure.

. Derno - Micosoft sbbedded Visual C++ - [Demo o - 100 _DEMO_DIALOG [Exstish (0801 (Bialas] s I Ell_il
] Fil: Edit Tiew Imert Projeot Bvild Tools Window Help — &l x]
[ eca@ % se - o | Gfaddr =] | [[peme  Zfwin32 v
“".‘Dr:-.ml:lDIg ;"[.E\II class ml:rnhmsijl & CDemoDlg | E 2 Y B | e
“Demu ~||STANDARDSDK =||Win32 [#CE ARMV4) Release ~|[STANDARDSDK Emulator
TE LI...I....I....I....I....I....I....I....I....I....I...._
=3 Demo resources * =
T Mg _ [ e—— F—
= 10D DEMO DIALOG s
-] lcon 2
= An: abl
-1 Version in
TODO: Place dislog controls hete, Mo
Z x @®
= m B
: s m
& o
: =1
i izl
a s | | B |
= - = v
=2 Clas... | @ Res... [[EIFileV..] |~ o |LI_I
[wlees s Emys = e |
Ready &
Fig. 5-1-10

2. By clicking the icon ﬂ to create a static text object.
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3. Right-click on the Static text object and select “Properties”.
4. When the Text Properties dialog is shown, set “Input DO Value” in the
“Caption” field.

Text Properties 2
44 % General | Styles | Extended Styles |

ID: [IDC_STATIC ~| Caption: |ITITDIREIT

v ¥Yisible ¥ Group
[” Disahbled [” Tab stop

Fig. 5-1-11

5. Click the icon ﬂ to create an edit box object.

6. Right-click on the edit box object and select “Class Wizard”.
7. When the MFC Class-Wizard dialog is shown, select the “Member
Variables® tab.

3 20 x]

Message Maps Member Variables | Automation | ActiveX Events | Class Info |

Project: Class name: Add Class... - |

Demo i T k|
Add Yariable... |

CiprojeciDemo\DemoDlg.h, C\projectiDemoiDemoDlg.cpp

Control IDs: Type. Member Delete Variable |

IDC_EDIT1
IDCANCEL Update Columns |

IDOK
Bind All |

Description:

0K | Cancel

Fig. 5-1-12
8. Click the “Add Variable“ button to add a new member variable.
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Add Member Variable 2] x|

Member variable name:
|m_DO
Cancel |

Category:
=

Variable type:

[CEdit |

Description:

map to CEdit member

Fig. 5-1-13
9. Set“m_DO” in the “Member variable name” field, and configure the
“Category:“ dropdown-box as “Control”, and “Variable type:“ as “CEdit”.
10. Once you have completed the above list of steps, click the “OK® button to
save the Member variable and close the dialog.

To create a Button:

1. Create a new button object by clicking on the icon ﬂ in the “Con..” window.

2. Right-click on the Button object and select “Properties”.
3. When the Push Button Properties dialog is shown, type “Digital Output”

into the Caption field (see figure), and close the dialog.
Push Button Properties

%  General | Styles | Extended Styles |

ID: [IDC_BUTTONI1 ~| caption: ; uf

v Yisible I Group
[ Disabled ¥ Tab stop

Fig. 5-1-14
4. Double-click on the Push Button object so that you can edit the button’s event
code. Then type “OnBtnDO” into the “Member function name:” field (see
figure 5-1-15), and click the OK button to display the Editor window.
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Add Member Fonction l‘ i'

Member function name: oK.
Cancel

Message: BN CLICKED
Object ID: IDC._ BUTTON1

Fig. 5-1-15
5. In the Editor window, type the code in as follows:

void CDemoDlg::0OnBtnDO()
{
// 10D0D: Add your control notification handler code here
int DOUal;
int slot=1;
TCHAR temp[48];

m_Dﬂ.GetwinduwText(temp,1ﬂ};
DoUal=_ttoi{temp);
DO_8{slot, DOUalj);

Fig. 5-1-16
6. Press CTRL+Home to move your cursor to the top, and then insert the
“#include “WinconSDK.h” ” within the header area.

4/ DemoDlg.cpp : implementation file
TEd

#tinclude “'stdafz.h"
#include “'Demo.h™
#include “DemoDlg.h*

#tinclude “"WinconSDE.h" "’f

#ifdef _DEBUG

#idefine new DEBUG_MEW

Hundef THIS_FILE

static char THIS_FILE[] = __FILE_ ;

Fig. 5-1-17

5.1.5 Build the Application Program

Microsoft eMbedded Visual C++ provides two ways for building an application

program. The first and most common method is to build the application program within
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the eMbedded Visual C*™* development environment. The second method is to build
the application program by using command-line tools within the MS-DOS prompt
environment. The procedure for building an application involves a number of items
namely the preprocessor, the compiler, and the linker. Their main functions are
described as below:
e The preprocessor prepares source files for the compiler by translating macros,
operators, and directives.
e The compiler creates an object file containing machine code, linker directives,
sections, external references, and function/data names.
e The linker combines the code from the object files created by the compiler
and from the statically-linked libraries, plus it resolves the name references,

and also creates an executable file.

The Building Process

The following diagram shows the components in the building process using
eMbedded Visual C++ and starting with the editor in which you create your source
code.

l—{ Editar I—l
+

Makefile I| Header Filas I

| Saurce

hello.cpp iostream. h

| |
+
| Preprocesszor I-q—
¥

| Coampilar I
T
| obiect File | hello.obj
*
Object Files I—>| Linker |4—| Libraries I

mlibcewq.lib

| Debug Version I |Re|ease "Jersinnl

hello,exe hello,exe

Fig. 5-1-18

If you build your program outside the IDE, you may use a makefile to invoke the
command-line tools. Microsoft eMbedded Visual C*™* provides the NMAKE utility for
processing makefiles. If you build your program within the IDE, the eMbedded Visual
C++ project system will use the project (.vcp) file to store the make information.
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The .vcp file is not compatible with NMAKE. However, if your program uses a makefile
rather than a .vcp file, you can still build it in the development environment as an
external project.

To Build the Demo Application

1. On the “Build“ menu, choose “Build Demo”.

2. If you have finished the above steps, you would obtain the following message
in the Output window, which means the execution application has been built.
Otherwise, you will get error messages. You would then need to debug the
source code and rebuild the application.

DemoDlg.cpp
Generating Code...
Linking...

Demo.exe — B errori(s), @ warning(S}

Fig. 5-1-19
3. If there no error messages are produced, you will find the Demo.exe file in
C:\Project\Demo\ARMV4Rel\.

5.1.6 Execute the Application Program on the Wincon-8000 Platform

When you have finished the building process for the Demo.exe, you could apply
the developed execute file (Demo.exe) into the Wincon-8000 controller unit. For
example, you can use a portable memory stick (Like Pen Driver) to store the file and
to copy it to Wincon-8000. In a following section, we will develop a method for how to
download the application to the main controller unit through the Ethernet (TCP/IP) or
RS-232 series protocol. The main idea for running the user program within the
WinCon-8000 target control device is to make the process simple just like in the

following steps.

1. Copy the Demo.exe from C:\Project\Demo\ARMV4Rel\ subfolder to the
Wincon-8000.
2. Double-click on the Demo.exe file to run it on the Wincon-8000, as shown in
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following figure.

Demo m m f

ToDD; Place dialog contrals here,

Input 0O Yalue 13

Digtal Output |

Fig. 5-1-20
3. Type “3" into the “Input DO Value” field (above figure), and click the “Digital
Output” button. Then, you can turn on the channel 0 and 1 of the Digital
output Module plugged into the slot 1 of Wincon-8000.
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5.2 Applications in Visual Studio VB .NET and C#.NET

What are Smart Device Extensions?

Smart Device Extensions (SDE) for Microsoft® Visual Studio® .NET allows you to
leverage all of your .NET programming skills to build Microsoft Windows® applications
for smart devices that support the Microsoft .NET Compact Framework. When using
SDE, you can produce applications for Pocket PC and Microsoft Windows CE .NET
platforms using the familiar Microsoft Visual Basic® .NET (or Microsoft Visual C#™)
language with the same tools and class libraries that are used to build .NET
applications for the desktop and for servers. Since these smart devices don't offer all
the features of their larger cousins, the hardest thing to master is learning which parts
of the Microsoft .NET Framework have been modified to align with the reduced
functionality of these more limited portable platforms. Fortunately, the Visual Studio
environment provides full support for this as well as enabling desktop debugging for

applications running on these platforms.

Creating applications using SDE from Visual Basic .NET is so straightforward that
you might be tempted to just jump right in by creating a new SDE project, dropping
some controls on a form, and writing some code. In fact, we're going to do just that in
a moment. But we are also going to step you through the entire development,
debugging, and deployment process and point out exactly where the special nature of
SDE development is different than developing desktop applications. And for those of
you who have a technical interest in how this stuff works, we will explain what's going

on under the hood.

What is C#£.NET?

Visual C# (pronounced C sharp) is designed to be a fast and easy way to
create .NET applications, including Web services and ASP.NET Web applications.
Applications written in Visual C# are built on the services of the common language

runtime and take full advantage of the .NET Framework.

C# is a simple, elegant, type-safe, object-oriented language recently developed

by Microsoft for building a wide range of applications. Anyone familiar with C# and
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similar languages will find few problems in adapting to C#. C# is designed to bring
rapid development to the C™ programmer without sacrificing the power and control
that are a hallmark of C and C**. Because of this heritage, C# has a high degree of
fidelity with C and C**, and developers familiar with these languages can quickly
become productive in C#. Besides, C# also provides intrinsic code trust mechanisms
for a high level of security, garbage collection, and type safety. C# supports single
inheritance and creates Microsoft intermediate language (MSIL) as input to native

code compilers.

C# is fully integrated with the .NET Framework and the common language
runtime, which together provide language interoperability, garbage collection,
enhanced security, and improved versioning support. C# simplifies and modernizes
some of the more complex aspects of C and C*", notably namespaces, classes,
enumerations, overloading, and structured exception handling. C# also eliminates C
and C™ features such as macros, multiple inheritance, and virtual base classes. For
current C** developers, C# provides a powerful, high-productivity language

alternative.

All the demo programs for Microsoft Visual Studio 2003 Visual Basic.Net and
C#.Net are given in the directory ““WINCON\DI_DO_Demo\VB.NET\Demo” and
“WINCON\DI_DO_Demo\C#\Demo”. They have been tested OK on WinCE.NET 4.1

or newer version platforms and on VB.NET or C#.NET development toolkit.

The demo programs have been implemented in the VB or C# applications through
the Wincon.DLL, which declares all functions for all Modules in WinCON-8000.

This section shows you the procedure for how to create the first demo program with
VB.NET or C#.NET development tools as below.

Create a new SDE project;

Add project reference for an application;

Design an application program;

Execute the application program on the Wincon-8000 platform;

a kw0 b=

Example list for the reference of user program design.
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5.2.1 Create a New SDE Project

Let's start with the traditional "Demo" application, which, while clearly trivial, still
illustrates in a nutshell the entire development process. We will assume you have
installed both Visual Studio.NET and the Smart Device Extensions (SDE)
development tools. Furthermore, you are trying to develop the user program to be
applied in the Wincon-8000 controller target device. The following steps are illustrated
in detail to explain the developing process.

1. For the first step, users need to open Microsoft Visual Studio .NET 2003
software. And then in the “File” menu, please select “New”, and choose the
project item to open the “New Project” dialog.

2. Open the "New Project" dialog, and select the development tools as

followings. Here we provide two ways for developing applications for
Wincon-8000.

(2a.) Select the "Smart Device Application" template from the "Visual

Basic Projects" folder (see Figure 5-2-1a).

X
Broject T}.I'l_:ues: Templates: I'Eil
-;;j Vizmal Bazic Projects | L i &
-] Visnal C# Projects Lgi‘“ﬂ e gaﬁ I
il Vigual J# Projects = )
i d Visal .:++r;]re;jem Windows:  ClassLibrary  Windows

L] Setop and Deployment Projects Applehy: Gt

-] Other Projects
fed ] Vizmal Stodio Solobion:

Iy S

% !

Wt ASP HET Web ASF NET Web
Application BEDVICE -

& project for ereafing an apphication for Pocket FC and rescuirce-constrained devices

Name: {Demo
Locatin: | C\progect -] Browss, |
Hew Solution Name:  {Demo v Create directory for Solotion

Frojectwill be created at C:".prc:jé{:t".DemJ:u".DemJ:u.

2les | ok | Cowel | Help |

Fig. 5-2-1a

(2b.) Select the "Smart Device Application" template from the "Visual
C# Projects" folder (see Figure 5-2-1b).
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Wew Project x|

Project Types: Ternplates: [E_il

] Visual Basic Projects ) o = -
e ViaI ol oot B il ﬁ] L

|;'| Vizual J# Frojects ; ; : .

a7 (] Visual C++ Projects TWindowes Clazz Libirarys T ind awes

] Betup and Deplosmment Projects Application Contro...

-] Other Projects p— 2
fed ] Vizmal Stodio Solobion: L%ﬂ Hé? I_é?

Bmeart Device ASPNET Web AST NET Web
Application . Application BEDVICE LI

Name: {Demo
Locatiom: IC:".prc:ject -] Browss, |
New Soluticn Name:  |Dema v Create directory for Solotion

Froject will be created st CiprojectiDemo'Desno.

2les | ok | Cowel | Help |

Fig. 5-2-1b
You can change the project location which is to be created, if so desired.
Give your application a Name (for example; "Demo"). This will create a new
directory under the defined Location to contain your application's source
code.
Click OK.
This will start the "Smart Device Application Wizard" (see Figure 5-2-2). At
this point you need to choose between developing for Windows CE and
developing for the Pocket PC, a specific type of Windows CE device. Your
choice will determine which project templates are used to construct your
initial blank application.
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Srmart Dewice- A pplicaton Wizand - Denio

Welcome to the Smart Device Application Wizard

This wizard creates a project ko develop an application to run on a smart device,

What platform do you want to target?

Pocket PiC

What project type do you want to create?

Awindows Spplicakion
Class Library
Console Application
Empty Project

You currently have the Following devices
installed Ehak will run an application taroeting
thiis platform,

Windows CE JNET Device
windows CE JMET Emulator (Default)
Pockek PC Device

Pockek PC 2002 Emulator

(o4 | Cancel | Help

Fig. 5-2-2

7. Choose the Platform (use “Windows CE” for the Wincon-8000 device).

8. Choose the Project Type. For the first simple application, which simply
displays a form on the device, choose "Windows Application".

9. Click OK and let the wizard create the project for you (this may take a

moment).

10. You should now be looking at a Visual Basic .NET(C# .NET) application that
looks somewhat like Figure 5-2-3a (Figure 5-2-3b for C#.NET). Your window
arrangement may quite likely be different since Visual Studio remembers the

layout you've configured in the past when developing other projects.
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Fig. 5-2-3b
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5.2.2 Add the Project Reference to an Application

The Wincon library contains all the module functions. Before you use the “Wcon”
keyword in the program design, you must add the Wincon.dll into the reference list of
your application. Please follow the below process to import Wincon.dll into the project

reference:

1. Open the "Add Reference" dialog by choosing Project—Add Reference
(see Figure 5-2-4).

Add Refersnce =
| Projects I
Browss, |
Cofiponert Waime l Versdoi | Path I - -
ICFDAS Dean Remote 7000/ 1.0.20 DAProgram Filesiicrosodt Vis... Select I
Ly Wen ~al UL A I esvtdicromtt Vis
Micmmft ‘qua]Basw: T10. 5EIEIEI ] D ".Prc:g:ram Files\Microsoft Wiz, .
Microsoft WindowsCE Forms 1.0.5000.0 DAPro gram Files'bicrosnft Vis.
mgcorlih 1.0.5000.0 DeAProgram Files\hd icrosoft Wiz, .
Ssterm 1.0.5000.0 LviProgram Files'Micromdt Vis...
Barstern. Data, 1.0.5000.0 DetProgram Fileshdiorosaft Wis .. —
Barstern. Data, Comumomn 1.0.5000.0 DrAProgram Filesthd iorosoft Wiz, .
Swstermn Data, 3q1C hient 1.0.5000.0 Do gram Files\bicromft Vis.
Bargtern. Data. Sglierer”e 1.0.5000.0 DeAProgram Filestbdicrosoft Wiz, .
Sorgtern Diraveing 1.0.5000.0 DrAProgram Filesthdicrosoft Wiz, . _:j
Saretern Met TeT10 1050000 T4 Prmararmn Filas bl irmnenft Wiz
welected Comprnests:
Component Hames I Tyvpe I AOumE I
o | Camel | Hep |
Fig. 5-2-4

2. Select the “ICP DAS Wcon Inside 1-8000/1-87K series modules for
Wincon-8000" in the list box, and click the “Select” button.

= Note: If you don’t find the “ICP DAS Wcon Inside 1-8000/1-87K series
modules for Wincon-8000" item in the list box then you can add the
“‘Wincon.DLL" file by using the button “Browse”. The default location of
the file is “C:\ Program Files\Windows CE Tools\wce410\SA_IA\Dotnet”.

3. If you use the VB.NET development tool in the list box, select the “mscorlib”
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file and click the Select button (the component “mscorlib” must appear in the
Selected Components area). Note: If you use the C#.NET development tool,
“‘MSCorLib” is the default project reference DLL. Therefore, the user does
not need to add this project reference to their application.

4dd Beference ]
| Projects |
Compoieit Name ] Versingn | Path I -
ICPDAY Deon Remate I-T0O004.. 1020 DeAProgram Filesthd iorozoft Wiz,
ICPDAR Weon Inside I-8000:1.., 1020 DoiProgram Files\hicromft Vis...
Microemnft VisnalBasic 7.0.5000.0 Di\Progran Filesbicromft Wiz

Micmft.WimlnwsﬂE.FDmls 1 EI 5000 EI D ".Prc:g:ram Fﬂes".l-{icrc::s::uft ‘.?13...

Sst 1050000 Ry s e

Sarstern. Data, 1.0.5000.0 LetProgram Filesthd icrosoft Wis. .
Swstern Date, Common 1050000 Do gram Files\Micromft Vis. .
Sorgtern. Data. Sg1C et 1.0.5000.0 DeAProgram Filesthd inrozoft Wiz,
Sstem. Date. S lPerverCe 1.0.5000.0 DoiProgram Files\hicromft Vis...
Bargtern Diraving 1.0.5000.0 DrAProgram Filesthdicrasaft Wis. .
Sarstern Met TeT1 0 10 &sO00 N TP eram Files bl irmnenft Wis .:.I

telected Components:

Component WName I Tupe | BONTEE: I Eemove |
ICPDAY Weon Insde I-800001-8...  NWET DehProgram Filestbd dnrosaft Vima. .
mcorlib NET DiAProgram Filesttd icrosaft Visma..

ZHE l Cancel Help

Fig. 5-2-5
4. Click OK to close the “Add Reference” dialog.

= Note: If the “The reference ‘Wincon.dIl’ may or may not be valid for the
active platform. Add references with care to ensure your application
will run correctly” message dialog pops up, Click “OK” to close this
message dialog. (See Figure 5-2-6)

Microzoft Development Environment x|

The reference Wincon.dll' maxr or may not be valid for the active platform. Add references with care to ensure your application

weill mon comectly.
0K |  Comcel |
Fig. 5-2-6

5. You have completed adding the “mscorlib” and “Wincon.dIl” references for
your application; now expand the “Demo” and “References” folders in the
“Solution Explorer” tab to make sure the “Wincon.dll” has been added into
the project references. (see Figure 5-2-7a of VB.NET, or Figure 5-2-7b of
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C#.NET).

solution Explarer - Dema !-ﬁuﬁnn Explorer - Demo B
2l g = E| R
'a Solotion Temo' {1 project) 'a Solution Demo' (1 project)
= (¢l Demo = 2 Demo
(=T E e ferences = =Y References
o =0 mscorlib e (D MECoiLib
+20 Bystem o 00 Bystemn
<20 Bystem Data e o Bystemn Data

< Svstemn Dranwing
= Svstemn. Windows. Fooms

=0 Eyrstern Draveing:
b =20 Bysten. Windows Fonns

~ o System XML - o0 System XML
PG e Wineon o 0 Wincon
Fe] Assemblylndo vb [#] Assemblylnto cs
- E&| Forml b - 5| Foonl oz
18 soluti [ BF Clas  [FResn | [ Soluti. | P Class |l Resn |
Fig. 5-2-7a Fig 5-2-7b

5.2.3 Design an Application Program

Take a moment to explore Visual Studio and note that the appearance is almost
identical to what you are used to when developing desktop applications by Visual
Basic .NET or Visual C# .NET. The first thing to be noticed is that some of the Toolbox
items in the Device Controls tab; for example: some dialogs (Color, Files, Font, Print)
and advanced user interfaces (Calendar, ImageList, DataGrid); are not included
within the development environment tools of the Smart Device Extension(SDE).
However, there is also a new Device Extension toolbar. And if you've selected
something on the Form (proceed to fit your target smart device), you may also notice

that there are fewer things listed in the Properties window.

Now let's do the remaining steps in building this small demo test program.

1. Right-click on “Form1” and select “View Code” from the pop-up menu.(see
Figure 5-2-8)

5 View Code
@ Lock Contools
B |

@‘ Properties
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Fig. 5-2-8
Move your cursor to the top and select the development tool you want by
using the following methods:
(2a.) In the VB.NET development tool, insert the “Imports Wincon” on the
first line location.

Start Page | Forml wb [Design]*  Forml wh* | LIRS
Im{(}emml} j |Im {Declarations) j

Imports Wincon ]

A

mPublic Class Forml
l Inherits Swstem Windows Formz Form

[Mrdows Form Uesigner zenerated code |

End Claszs

.
| | _*I_‘

Fig. 5-2-9a

(2b.) In the C#.NET development tool, insert the “Using Wincon;” into the
command line after “using System.Data;” as shown in following figure
5-2-9b.
Htart Page | Forml ¢z [Desien]*  Forml .es® |
i&.;llf:nm Forml ;! i:-.tFl:uxm‘u{.‘-

Suzing Svsten;
uEing System Drawing ;
uzing Svstem.Collections;
uzing System Windows Forme;
using Systen Data;
uzing Wincon;

g el

= namespace Demo

[

PO amimma gy s

SED Bommary description for Forml.

: S = faumme ty s

= public class Fomml - Svstem Windows Forms _Form

{
Jj public Formli) -
4| | b

Fig. 5-2-9b
Click the “Form1.vb [Design]*” (or “Form1.cs [Design]*’) tab in the
workspace window above to change the code view window to the form design

window.

Click the icon _# Label | on the “Toolbox” window to create a label text
object.

Type “Input DO Value” into the “Text” field from the “Properties” window.
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Properhes

ILabell Syster. Windows Forms Labe. l|

=REE

Location 136, 72 e
Locked Falw
Modifiers Friend
Size 100, 20
Input DO Yalue
Texthlizn TopLeft
Visible True =
I Text
Fig. 5-2-10
6. Click the icon [Pl TexiBox | 15 create a TextBox object.
7. Delete “TextBox1” text in the “Text” field from the “Properties” window.
8. Create a new button object, by clicking the icon 2b] Button | in the

“Toolbox” window.
9. Type “Digital Output” in the “Text” field from the “Properties” window.
10. Double-click on the button to open the corresponding code window and enter
the following line of code in the button's Click event handler:
(10a.) VB.NET
Dim slot As Integer = 1
Dim data As Integer
data = Val(TextBox1.Text)

Start Page | Forml «b [Design]*  Forml wb* | 9 X
% Buttonl | | #Click ~]

s Public Class Forml -

Inheritz Svstem Windows Forms Form =]

Friend WithEvents Labell Az Swstem Windows Forms.Label
Friend WithEvents TextBoxl Az Swstem Windows Forms TextBox
Friend WithEventz Buttonl &= Swstem Windows Formz Button

gif Windows Form Desiznet generated coda |

=] Private Sub Buttonl Click{BuvVal sender Az Bwstem_Object, BwVal e b= Bus
Iim =lot &= Integer = 1
Dim data b= Integer

data = Val(TextBoxl Text) - i
- End Bub -
Fig. 5-2-11a
(10b.) C#.NET
int slot=1;
byte data;
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data=Convert.ToByte(textBox1.text);

Start Page | Forml s [Desgn]*  Forml .cs*| B L 4
iagDemJ:u.Fnrml j Eﬁhutb:unl_l:]jﬂk{u:uhject send ex,=rstem Even j
: —
dpplication Run{new Forml{}); A
=] private woid buttonl_Click{object zender, Svstem.Eventfrzs e)
f
int =lot=l;
byte data;
data=Convert ToBwie(textBoxl Text);
1
: 1
1
) ==
4| | i

Fig. 5-2-11b

11. Insert a new line and type “Wcon.”. And then a list box window will pop up as
follows to prompt and help the user to add a function for the WinCon-8000
device controller unit.

Start Page | Formi vh [Desizn]*  Forml vb* | 4 box
|_,;,$ Einttonl L! | # Click LI
Imports Wincon -—

gPublic Class Forml

Inherits Swstem Windows Forms _Form

Friend WithEvents Lahell &z Svstem Windows . Forms . Lahel
Friend WithEvents TextBoxl b= Zwstem Windows .Forms TextBox
Friend WithEvents Buttonl &= Zwstem Windows Forms Button

m] Windows Forn Tesigner gensrated cods |

=} Private 3ub Buttonl ClickiByWal sender bz Swstem.Object, ByvWal e s Svstem Ew
Dim zlot &= Integer = 1
Dim data b= Integer
data = Wal({TextBoxl Text)
Weomn.
End g 19057 5
e % 18058 =
‘47".; 18060
‘47".; 18062
P JEENTEY
‘47".; 18065
‘47".; 18066
‘47".; 18068
‘47".; 18069 :|
“_I ‘47".; 18090 j

Fig. 5-2-12
12. Select “18064” from the pop-up list box and press the TAB key.
13. After typing “.” behind the “18064”, a list box pops up a hint for available
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functions that can be used for this selected module, as shown in the following
figure.

mPublic Clazs Forml

Inherits Svztem Windows . Forms Form

Friend WithEvents Labell Az Zwstem Windows Forms . Label
Friend WithEvents TextBoxl Az Swstem Windows Forms TextBox
Friend WithEvents Buttonl &z Swstem Windows . Formz Button

[ Windows Form Desigher gemetaied code |

=] Private Sub Buttonl Click(ByVal sender Az Swstem Ohject, BvVal e b= Swstem Eve
Dim =zlot b= Integer = 1
Dim data bz Integer
data = Val(TextBoxl Text)
Poon 18064 .
End Bub - s St
“End Class S

[Public Shared Sub DO_Bisdot As Tnteger, cdata Az Byl

Fig. 5-2-13

14. Select “DO_8" from the pop-up list box and press the TAB key. Then input
the parameters of the function, which means inputting “(slot, data)”.

Frivate Sub Buttonl Click{By¥al sender As private void buttonl Clickiobject sender
Dim =lot &z Integer = 1 I = :
Oim data b= Integer ; s
data = Val{TextBoxl Text) ;Eteséztal',

Woon 18064 10 _Bislot, data) data=Convert. ToBvtel textBoxl Text);

End Sub Weom 18064 10 B(szlot, data):

1
Fig. 5-2-14a (for VB.Net) Fig 5-2-14b (for C#.Net)

5.2.4 Building an Application Program

When you have finished the above processes, you could build an application by
following the below steps.

1. In the toolbox menu select “Release” from the solution Configurations in the
Combo box.

File Edit ¥iew FProject Build Debng  Toole  Window Help

G- % | B ||Debug B g m ~ | BT
- Windows CE NET Em E&b | E .
% .
Fig. 5-2-15
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2. Inthe toolbox menu select “Windows CE .NET Device” from the Deployment
Device Combo box. (see Figure 5-2-16)

Filew Edit ¥iew Project Build Debog  Toole Window Help
G- & | E | Reless - Sub ol PP il

| Windows CE NET Emulstor (Defanlt) | = =5 N )
Windows CE NET Device

:|Wim:l|:|ws CE NET Emulator (Defanlth % >
_|Pocket PC Device
-\ Pocket PC 2002 Emulator

Fig. 5-2-16

3. On the “Build“ menu, choose “Build Demo”.

4. If you have finished steps 1~4, you would obtain the following message in the
Output window, which means the execution application has been built.
Otherwise, you will get error messages. Then you will need to debug the
source code and rebuild the application.

Chatput

i
]
i
1
'
]
i
1
'
]
i
1
'
]
i
1
'
]
i
1
i

=
(=]
=
[ar)
i
]
i
1
'
]
i
1
'
]
i
1
'
]
i
1
'
]
i
1
'
]

Rebuild All: 1 succeeded, 0 failed, 0 skipped _l

4 | 2

[ Task Lizt Outputl %Index Results for Dim keyrwond |

(S B8

Fig. 5-2-17
5. You can find the Demo.exe file in C:\project\Demo\Demo\bin\Release\.

5.2.5 Execute the Application Program on the Wincon-8000 Platform

When you have finished the building process for the Demo.exe, you could apply
the developed execution file; Demo.exe; into the Wincon-8000 target controller device.
For example, you can use a portable memory stick (Like Pen Driver) to store the file
and copy it to Wincon-8000. Or later on, we will develop a method on how to
download the application to the main controller unit through the Ethernet (TCP/IP) or
Rs-232 series protocol. The main idea for running the user program in the
WinCon-8000 target control device is because it is very simple as shown in the

following steps.
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1. Copy the Demo.exe and Wincon.DLL from the C:\Project\Demo\ARMV4Rel\

subfolder to Wincon-8000.
2. Double-click on the Demo.exe file to apply it into Wincon-8000, as shown in

the following figure.

Inupt DO Value 3 |

_ Digital Output |

Fig. 5-2-18

3. Type “3" into the “Input DO Value” field (above figure), and click the “Digital
Output” button. Then, you can turn on channels 0 and 1 on the Digital output
Module plugged into slot 1 of Wincon-8000.

WinCon-8000 Getting Start Manual-- 61



